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In This Guide ...
In This Guide ...

This guide contains reference information on the interface between Agilent 
OpenLAB CDS ChemStation Edition and the central data storage provided by 
OpenLAB ECM or OpenLAB Data Store. It also describes the settings required 
by 21 CFR Part 11, and provides information on the workflows for 
ChemStation using a central data storage.

1 Introduction

This chapter introduces the integration of a central data storage (OpenLAB 
ECM or OpenLAB Data Store) with OpenLAB CDS ChemStation Edition. It 
also describes the requirements of 21 CFR Part 11. In the following, the term 
ChemStation refers to Agilent OpenLAB CDS ChemStation Edition.

2 Basic Concepts

This chapter describes how to log in to the central data storage system in 
ChemStation, explains the user interface items and toolbars related to the 
central data storage, and describes the main preference settings.

3 Working with ChemStation and Central Data Storage

This chapter describes the basic workflows for ChemStation with a central 
data storage system. There are four data-related workflows and two workflows 
for methods, sequence templates, or report templates.

4 Administration Regarding 21 CFR Part 11 Compliance

This chapter explains the purpose of 21 CFR Part 11 and how the integration 
of ChemStation with a central data storage system addresses the requirements 
of 21 CFR Part 11.
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In This Guide ...
5 Filter and Search Options

This chapter provides an overview of the filter and search options for 
ChemStation data in the central data storage system.

6 Troubleshooting

The chapter gives some elementary troubleshooting hints.

7 Appendix
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This chapter introduces the integration of a central data storage (OpenLAB 
ECM or OpenLAB Data Store) with OpenLAB CDS ChemStation Edition. It also 
describes the requirements of 21 CFR Part 11. In the following, the term 
ChemStation refers to Agilent OpenLAB CDS ChemStation Edition.
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1 Introduction
Terms and Abbreviations
Terms and Abbreviations

Table 1 Terms and Abbreviations used in this document

Term Description

ChemStation OpenLAB CDS ChemStation Edition

EZChrom OpenLAB CDS EZChrom Edition

Data Store OpenLAB Data Store

ECM OpenLAB Enterprise Content Manager

RC .Net RapidControl .Net Interface
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Introduction 1
What is a Central Data Storage?
What is a Central Data Storage?

Agilent provides two systems for central data storage:

• OpenLAB Data Store, which is available as an all-in-one server installation 
as an option with OpenLAB CDS. It is designed for small laboratories with 
up to 15 instruments.

• OpenLAB ECM, which is available as a standalone product. It is designed 
for laboratories with more than 15 instruments.

Both systems are web-based electronic libraries that allow you to safely 
archive and catalog any electronic file. You can store and index analytical raw 
data, reports, and all other types of documents. The stored files can be shared 
with other users.

You can store any electronic file type, such as Microsoft Office documents, 
Adobe PDF documents, images, and molecular drawings, as well as raw data 
and reports generated by ChemStation.

Either of these central data storage systems allow you to easily collect, 
organize, search, and review all of your data. They automatically extract 
searchable metadata from files, and provide powerful search capabilities. ECM 
additionally provides embedded viewers for many file types.

The interface to the central data storage system is opened via Microsoft 
Internet Explorer, also referred to as the web client.

In this document, the terms central data storage or central repository refer 
to instances of either OpenLAB ECM or OpenLAB Data Store. As the interface 
and workflows for both systems are very similar, the specific product names 
are only used in places where there is a difference in associated concepts or 
procedures.
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1 Introduction
Using ChemStation with Central Data Storage
Using ChemStation with Central Data Storage

OpenLAB CDS ChemStation Edition provides an interface to the central data 
storage, which enable you to store analytical data and reports in a secure 
location. From ChemStation, you can log in to the central data storage and 
store all kinds of ChemStation files in the central data repository:

• Methods (*.m)

• Sequence templates (*.s)

• Data files (*.d)

• Report templates for Intelligent Reporting (*.rdl)

• Reports (*.pdf, *.xls, *.doc, or *.txt)

• Library files (*.uvl)

• Column databases (*.mdb)

• Easy Sequence templates (*.est)

• Classic report templates (*.frp)

The storage of ChemStation data can be either automatic (that is, at the end of 
a single run or sequence) or manual. The data can later be downloaded to 
ChemStation for review or reprocessing at any time.

Furthermore, OpenLAB CDS ChemStation Edition in combination with 
central data storage offers features that enable users to comply with 21 CFR 
Part 11 and similar regulations for electronic records and electronic 
signatures:

• Mandatory login/connection to the central data storage system

• Configurable session locking

• Configurable ChemStation user roles and privileges

• Full data traceability through audit trails for methods and results

• Full data versioning
10 ChemStation with Central Data Storage Concepts Guide



Introduction 1
Using ChemStation with Central Data Storage
You can use OpenLAB ECM in the following installation scenarios:

• Workstation

• Networked Workstation

• Distributed System

You can use OpenLAB Data Store in the following installation scenarios:

• Networked Workstation

• Distributed System

The main workflows for the transfer of raw data and methods/sequence 
templates/report templates are listed below. These workflows indicate the 
system activities in relation to the work processes.
ChemStation with Central Data Storage Concepts Guide 11



1 Introduction
Using ChemStation with Central Data Storage
Overview of data-related workflows

Figure 1 Overview of data-related workflows
12 ChemStation with Central Data Storage Concepts Guide



Introduction 1
Using ChemStation with Central Data Storage
Workflow 1: Raw data acquisition and automatic transfer to the central 
repository

1 Analytical raw data is acquired using ChemStation.

2 The raw data is automatically uploaded to the central repository using the 
configured path definitions immediately after the single run/sequence is 
finished.

3 The data is added to the defined storage location.

Workflow 2: Offline revision during acquisition

1 Analytical raw data is acquired using ChemStation.

2 While the acquisition is still running, part of the data is changed using an 
offline ChemStation.

3 The raw data is automatically uploaded to the central repository using the 
configured path definitions immediately after the single run/sequence is 
finished.

The initial version of the data is added to the defined storage location.

4 After work in the offline ChemStation is finished, the changed data is also 
automatically uploaded to the central repository.

The second version of the data is added to the central repository.

Workflow 3: Reprocessing data and automatic upload to the central 
repository

1 Existing analytical data is loaded from the central repository into 
ChemStation.

2 The data is reprocessed in ChemStation.

3 The data is automatically uploaded to the central repository. The storage 
location in the repository is defined by the original path definitions of the 
downloaded data.

4 A new version of the data is added to the central repository.
ChemStation with Central Data Storage Concepts Guide 13



1 Introduction
Using ChemStation with Central Data Storage
Workflow 4: Import after reprocessing

1 Existing analytical data is opened locally.

2 The data is reprocessed in ChemStation.

3 After reprocessing, the data is automatically uploaded to the central 
repository. The storage location in the repository is defined by the current 
preferences in ChemStation.

4 The initial version of the data is added to the central repository.
14 ChemStation with Central Data Storage Concepts Guide



Introduction 1
Using ChemStation with Central Data Storage
Overview of workflows for methods/sequence templates/report 
templates

Figure 2 Overview of workflows for methods, sequence templates, or report templates
ChemStation with Central Data Storage Concepts Guide 15



1 Introduction
Using ChemStation with Central Data Storage
Workflow 1: Uploading a new method, sequence template or report 
template

1 A new method, sequence template, or report template is created.

2 The method, sequence template, or report template is uploaded to the 
central repository using the path selected by the user.

3 The version 1 of the method, sequence template, or report template is 
automatically created in the central repository.

Workflow 2: Saving a changed method, sequence template or report 
template

1 An existing method, sequence template, or report template is loaded from 
the central repository.

2 The method, sequence template, or report template is modified in 
ChemStation.

3 The changed method, sequence template, or report template is saved to the 
central repository.

4 A new version of the method, sequence template, or report template is 
automatically created in the central repository.
16 ChemStation with Central Data Storage Concepts Guide



Introduction 1
Storage Model in OpenLAB ECM and OpenLAB Data Store
Storage Model in OpenLAB ECM and OpenLAB Data Store

File Management in ECM

ECM provides a four-level data storage model with the structure of Location, 
Cabinet, Drawer, Folder. The Location, Cabinet, Drawer and Folder names 
comprise the path name (called either LCDF path or Remote Data Path) of the 
storage location. Data is stored at Folder level only. 

The ECM program’s content structure is similar to rooms filled with file 
cabinets. Each cabinet has multiple drawers, which contain hanging folders. 
Finally, paper files are stored in the folders. The LCDF structure can be 
created using the ECM Web Client. In addition, it is possible to create 
additional Locations, Cabinets, Drawers, and Folders using the ChemStation 
Remote Data Path. In ChemStation, it is also possible to set predefined tokens 
for the Drawers and Folders.

In the ECM tree view, locations are denoted by a house icon. Inside each 
Location, Cabinets are denoted by the file cabinet icon. Inside each Cabinet, 
Drawers are denoted by the drawer icon. Finally, inside each Drawer, Folders 
are denoted by the folder icon. The entire content structure appears in the 
Content book.

Figure 3 LCDF structure in ECM
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1 Introduction
Storage Model in OpenLAB ECM and OpenLAB Data Store
Uploaded objects can be stored in the lowest (i.e. Folder) level only. It is not 
possible to upload data to other levels of the hierarchy.

For convenience, you can use tokens for the Location, Cabinet, Drawer, and 
Folder. The system then automatically creates the corresponding path 
elements. The following tokens are available: instrument name, operator 
name, instrument number, or computer name.

File Management in Data Store

OpenLAB Data Store provides a multi-level storage model. The number of 
levels is not limited, and you can store your data at any folder level.

Figure 4 Folder structure in Data Store

For convenience, you can use tokens for all elements of the Remote Data Path. 
The system then automatically creates the corresponding path elements. The 
following tokens are available: instrument name, operator name, instrument 
number, or computer name.
18 ChemStation with Central Data Storage Concepts Guide



Introduction 1
21 CFR Part 11 Compliance
21 CFR Part 11 Compliance

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-based 
documentation into electronic records. This rule is known as 21 Code of 
Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all 
industry segments regulated by the FDA.

21 CFR Part 11 includes the US Federal guidelines for storing and protecting 
electronic records and applying electronic signatures. The intent of these 
guidelines is to ensure that electronic records subject to these guidelines are 
reliable, authentic, and maintained with high integrity.

OpenLAB CDS ChemStation Edition in combination with OpenLAB ECM or 
OpenLAB Data Store provides the necessary controls for managing system 
access, audit trail functions, versioning of ChemStation data, and electronic 
signature functions. These systems ensure secure record keeping and data 
archival.
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21 CFR Part 11 Compliance
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This chapter describes how to log in to the central data storage system in 
ChemStation, explains the user interface items and toolbars related to the 
central data storage, and describes the main preference settings.
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2 Basic Concepts
Login and Lock Options
Login and Lock Options

User Permissions

You start ChemStation from the OpenLAB Control Panel. To prevent 
unauthorized access, OpenLAB CDS ChemStation Edition with central data 
storage requires authentication with a user name and password. With ECM, 
OpenLAB Shared Services use ECM as an external authentication provider. 
With Data Store, OpenLAB Shared Services act as the authentication provider. 
Users can be set up in OpenLAB Shared Services or can be imported from 
local Windows user management, from Windows Active Directory domain, or 
from Windows NT 4.0 Domain. You log in with your user credentials of the 
corresponding system.

You need specific user privileges for working with OpenLAB CDS as well as for 
working with the central data storage system. You specify the user privileges 
as follows:

• OpenLAB CDS privileges are set in the OpenLAB Control Panel.

• ECM privileges are set directly in OpenLAB ECM.

• Data Store privileges are set in the OpenLAB Control Panel.

For more information on user privileges, see “Users, Roles, and Privileges 
Concept with ECM” on page 93 and “Users, Roles, and Privileges Concept with 
Data Store” on page 95.
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Basic Concepts 2
Login and Lock Options
User Credentials

The Login dialog requires you to enter a set of valid authorization credentials 
in order to log in to OpenLAB Control Panel.

You need to enter the following login details:

• Login: the user name defined in OpenLAB Shared Services.

With ECM, this is the ECM user, which can be a Windows domain user or an 
ECM built-in user. With Data Store, this is the OpenLAB Shared Services 
users, which can be OpenLAB Shared Services internal users, Windows 
domain users or Windows local users.

• Password: the password provided by your administrator, which can be 
changed on request (for 'built-in' users), or the password of your NT domain 
account, if you are logging in using your NT domain user name.

• Domain: the domain administrating the users

ChemStation Operator Name

ChemStation stores the operator name in the sample info (when running 
single samples) or in the sequence parameters (when running a sequence). 
With ECM or Data Store as an authentication provider, this ChemStation 
operator name is your user name in the data management system. The 
operator name cannot be overwritten.
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2 Basic Concepts
Login and Lock Options
Session lock

If you leave the ChemStation computer for a period of time, you can lock 
ChemStation so that no other user can access the program. This is a safety 
feature to ensure that there is no unauthorized access to ChemStation. When 
you activate the session lock, you or another user must first provide a valid 
login before continuing to work with ChemStation.

In ChemStation, there are the following options to activate the session lock:

• Privately (User > Lock Session > privately): Only the user who activated the 
session lock, or a user with the Break Session Lock privilege, can log in.

• Non-privately (User > Lock Session > non privately): Any valid user can log in. 
This is useful, for example, if there is a shift change, and the leaving 
personnel secure ChemStation until the personnel of the new shift start 
work.

• Toolbar lock button: The toolbar lock button can be configured to lock the 
ChemStation session privately or non-privately.

• Time-based: Depending on the configuration in OpenLAB Control Panel, 
ChemStation is automatically locked after a given period of time without 
any user interaction (Inactivity Timeout setting in the Security Policy area of 
OpenLAB Control Panel).

The time-based session lock can be configured to lock the ChemStation 
session either privately or non-privately (see “ChemStation Administration 
Tool” on page 96).
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Basic Concepts 2
User Interface in ChemStation Related to the Central Data Repository
User Interface in ChemStation Related to the Central Data 
Repository

Overview of the interface elements

When connected to a central data storage system, additional menus, menu 
items, and interface elements are available in ChemStation. Depending on the 
external system, they are automatically labelled either with ECM or with Data 
Store.

Menu Element type Description

Method Enable Audit Trail 
Command

See “Method Audit Trail” on page 74. The 
Method Audit Trail can also be enabled on a 
system without central data storage.

Sequence > Sequence Parameters Sequence Parameters Tab See “Remote Data Path as Sequence 
Parameter” on page 41

Report Report History Command See “Report History” on page 76

View > Preferences Tabs In the Preferences 
dialog:
• Transfer Settings
• Audit Trail

See “Preferences” on page 30 and “Audit Trails 
and Logbooks” on page 74. The Method Audit 
Trail and Results Audit Trail can also be 
enabled on a system without central data 
storage. Therefore the Audit Trail tab is visible 
in the Preferences also in a system without 
central data storage.

ECM or Data Store ECM or Data Store Menu See “The ECM or Data Store menu” on page 27

User User Menu See “The User menu” on page 29. If 
authentication has been set up, the User menu 
is also visible on a system without central data 
storage.
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2 Basic Concepts
User Interface in ChemStation Related to the Central Data Repository
Toolbar (depending on the current view) • Shortcuts to several 
commands of the ECM 
or Data Store and User 
menus

• LCDF info

• Path info in the Data Analysis view: shows 
the remote path of a file that has been 
stored to the central repository.

• Path info in the Method and Run Control 
view: shows the remote path for automatic 
upload after acquisition.

• With ECM, the path is shown with 
backslashes; with Data Store, it uses 
forward slashes (for example, 
Location/test/test/test).

Several details related to the central 
repository in the System Diagram in 
Method and Run Control view (classic 
ChemStation only).

Details view The following details are available:
• Path
• Operator
• Automatic transfer after acquisition
• Automatic transfer after reprocessing
• Automatic transfer after any data 

modification
• Automatic import after reprocessing

Menu Element type Description
26 ChemStation with Central Data Storage Concepts Guide



Basic Concepts 2
User Interface in ChemStation Related to the Central Data Repository
The ECM or Data Store menu

All commands related to the central repository are available in a separate 
menu. Depending on the central data storage system, the menu is named 
either ECM or Data Store. The menu and its commands depend on the view that 
is currently active. See the following table for details.

NOTE There is no ECM or Data Store menu in the Verification (OQ/PV) or Diagnosis view.

Command Description Available in ChemStation 
views

Update Methods ...
Update Sequences Templates ...

Update all methods/sequence templates that are 
stored in the local file system with the current 
version from the central repository (if it exists 
there). Local changes are overwritten.

• Method and Run Control

Update Report Templates ... Update all report templates that are stored in the 
local file system with the current version from the 
central repository (if it exists there). Local 
changes are overwritten.

• Report Layout (Intelligent 
Reporting)

Cleanup Data The Cleanup Data command deletes all data or 
result sets from the local file system that exist in 
the central repository as well. Make sure you 
uploaded the latest version to the central 
repository before you confirm this command. See 
“Cleanup Data on Shutdown” on page 35.

• Data Analysis

Manage Queue With the Manage Queue command you can 
continue any interrupted data upload to the 
central repository. See “Manage Queue on 
Connect” on page 35.

• Method and Run Control
• Data Analysis

Preferences
See “Preferences” on page 30 for more details on 
the Preferences dialog.

• Method and Run Control
• Data Analysis
• Report Layout (Intelligent 

Reporting)

Method-related commands:

Load Method ...

Save Method

See “Workflows for Methods and Templates” on 
page 59

• Method and Run Control
• Data Analysis
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User Interface in ChemStation Related to the Central Data Repository
Data-related commands:

Load Data ...

Save Data

Save Data As ...

See “Data-related workflows” on page 48 • Data Analysis

Commands related to the sequence 
template:

Load Sequence Template ...

Save Sequence Template

See “Workflows for Methods and Templates” on 
page 59

• Method and Run Control

Commands related to report 
templates:

Load Report Template

Save Report Template

See “Workflows for Methods and Templates” on 
page 59

• Report Layout (Intelligent 
Reporting)

Commands related to reports:

Load Report Template

Save as PDF

Save as XLS

Save as DOC

Save as TXT

• You can load a specific report template from 
the central repository. 

• You save the report generated with this 
template as a PDF, XLS, DOC, or TXT file to the 
central repository. TXT files do not contain 
any graphical information.

• Review (only available with 
Intelligent Reporting) 

Download Files ... Download library files (*.uvl), column databases 
(*.mdb), Easy Sequence templates (*.est), and 
classic report templates (*.frp) from the central 
repository.

• Method and Run Control
• Data Analysis

Upload Files ... Upload library files (*.uvl), column databases 
(*.mdb), Easy Sequence templates (*.est), and 
classic report templates (*.frp) to the central 
repository. 

• Method and Run Control
• Data Analysis

Command Description Available in ChemStation 
views
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Basic Concepts 2
User Interface in ChemStation Related to the Central Data Repository
The User menu

Command Description Available in ChemStation 
views

Change User ... Log in as a different user (only affects the 
ChemStation login, not the OpenLAB Control 
Panel login).

• Method and Run Control
• Data Analysis
• Review
• Report Layout

Lock Session • privately
• non privately
See “Session lock” on page 24.

• Method and Run Control
• Data Analysis
• Review
• Report Layout
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2 Basic Concepts
Preferences
Preferences

The Preferences dialog contains two tabs that are relevant to the central data 
storage system: the Transfer Settings tab and the Audit Trail tab.

On the Transfer Settings tab, you must specify the following preferences in order 
to automatically store ChemStation data to a central repository:

• Path

• Automatic Data Transfer Settings

• Transfer Management Settings

Figure 5 Transfer Settings tab in the Preferences dialog

Each of these items can be specified independently for each instrument. 
Offline and online sessions are automatically synchronized. 

NOTE You can change these settings for all ChemStation instances on the client PC in one single 
step by using the ChemStation Administration Tool (see “ChemStation Administration 
Tool” on page 96). If settings have been specified for all ChemStation instances on the 
computer, you cannot change the settings in the Preferences dialog.
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Basic Concepts 2
Preferences
On the Audit Trail tab, you can enable the Method Audit Trail and Results Audit 
Trail. For details on audit trails see “Audit Trails and Logbooks” on page 74.

Figure 6 Audit Trail tab in the Preferences dialog

Remote Data Path

The remote data path needs to be specified in order to save the data to the 
correct location in central repository.

In the Preferences dialog, the Transfer Settings tab (see Figure 5 on page 30) 
allows you to define the Path setting. This path reflects the LCDF structure in 
ECM, shown with backslashes, or the folder path in Data Store, shown with 
forward slashes.
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Preferences
ChemStation Rev. B and OpenLAB CDS ChemStation Edition Data 
in one ECM

In ECM, you may have stored data from different ChemStation revisions, for 
example, from rev. B and OpenLAB CDS ChemStation Edition (rev. C). If you 
work with ChemStation rev. C, you can load and process data from 
ChemStation rev. B. However, if you work with ChemStation rev. B, you can 
only process data from this revision (or older), you cannot process data from 
rev. C.

Server/Account

Here, you specify the server on which the central data storage system is 
installed. For ECM, you must also specify the ECM Account.

ChemStation obtains this information automatically from OpenLAB Control 
Panel. If the fields are empty or do not match the current configuration, you 
can click Get Server to reset the fields. ChemStation then keeps the information 
for future sessions.

CAUTION Wrong results or incompatible data

If you reprocess ChemStation rev. C data in ChemStation rev. B, you may obtain wrong 
or incomplete results.

If you reprocess ChemStation rev. B data in ChemStation rev. C, it may no longer be 
possible to reprocess these data in ChemStation rev. B.

➔ Clearly separate the files from ChemStation rev. B and ChemStation rev. C in ECM.

➔ With OpenLAB ECM Enterprise, we recommend using different ECM Accounts for 
ChemStation rev. B data and ChemStation rev. C data.

➔ With OpenLAB ECM Workgroup, use clearly separated LCDF locations.

NOTE If you manually enter the server name or ECM Account name, and the information does not 
match the configuration used in OpenLAB Control Panel, data upload will fail.
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Preferences
Path

To specify the storage location in the central repository, you can either browse 
to a an existing storage location in the central repository using the button with 
the three dots [ ], or click the arrow [ ] to select predefined tokens for 
automatic path creation. With these tokens, the system automatically creates 
the required items if they do not already exist in the central repository. 
Tokens are available for the instrument name, the user name, the instrument 
number, or the computer name.

Alternatively, the path can be specified as Sequence Parameter (see “Remote 
Data Path as Sequence Parameter” on page 41).

With ECM, uploaded files can be stored only at the Folder level. With Data 
Store, uploaded files can be stored at any level.

Automatic Data Transfer Settings

In the Preferences dialog (View > Preferences), the Transfer Settings tab allows you 
to specify the automatic settings for the transfer of raw data. The transfer 
settings, as well as the Remote Data Path, are used to automatically upload 
data to the central data storage.

NOTE If no path is specified, a warning message will be shown at ChemStation startup.

NOTE In ECM, there are separate privileges to create content and create folders. If you use 
tokens, make sure you have the required privileges in ECM to create folders! Alternatively, 
another user who has the required privileges can create the necessary folders in advance.

NOTE If the connection to the central data storage is lost for any reason, the data cannot be 
automatically uploaded as specified in the transfer settings. The data is then queued in the 
Queue Management (see “Queue Management” on page 37).

NOTE If you perform data acquisition from the Diagnosis view or OQ/PV view, the transfer 
settings are ignored. The analytical raw data is written to the local ChemStation data file 
system as predefined in the diagnosis or verification methods.
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After Acquisition

If you select this check box the data is automatically uploaded to the central 
repository after an acquisition. The raw data files are written to the local 
ChemStation file system while the sequence is still running. When the 
complete sequence is finished, the raw data files are packed in an SSIZip file 
which is then uploaded to the central repository.

For more information, please refer to “Workflow 1: Acquisition and automatic 
upload” on page 48.

After Any Data Modification

If you select this check box, the result set is automatically uploaded to the 
central repository after you changed the data analysis parameters for a 
sample. The data is uploaded even if you do not reprocess the sequence.

For more information, please refer to “Workflow 2: Offline review during 
acquisition” on page 51.

After Reprocessing

If you select this check box, the result set is automatically uploaded to the 
central repository each time after you reprocessed the sequence.

For more information, please refer to “Workflow 3: Reprocessing data and 
automatic upload” on page 54.

Import after Reprocessing

If you select this check box, a sequence that is only stored locally is 
automatically uploaded to the central repository after reprocessing. This 
setting is useful, for example, if you reprocess data from an older version of 
ChemStation.

For more information, please refer to “Workflow 4: Import after 
reprocessing” on page 57.
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Manage Queue on Connect

If the connection to the central data storage is lost for any reason, a running 
data upload might be interrupted. In this case, the remaining data is written 
to an internal queue. 

If you select the check box Manage Queue on Connect, ChemStation tries to 
upload the remaining data once the connection the central data storage is 
re-established.

Alternatively, you can open the Queue Management dialog (see “Queue 
Management” on page 37) at any time with the ECM > Manage Queue or Data 
Store > Manage Queue command in the Data Analysis view. The Queue Management 
dialog box allows you to manage the export of residual ChemStation data to 
central data storage after, for example, a network failure. You can process the 
queue, save selected items to the local computer, or delete items from the 
queue. If you delete an item from the queue, it will not be transferred to 
central data storage, but an entry will be made in the audit trail in the central 
data storage system. 

Cleanup Data on Shutdown

If you select this check box, upon shutdown ChemStation checks the local file 
system for files that have already been stored in the central repository. It 
deletes all local data and sequence files that are stored in the central 
repository as well. Methods and sequence templates remain on the local file 
system.

CAUTION Inadequate check box selection

Loss of data

➔ If you select the Cleanup Data on Shutdown check box, you should also select the 
Automatic Data Transfer Settings After Acquisition, After Reprocessing, and After 
Any Data Modification. Otherwise, if the users forget to upload the data to the 
central data storage before closing ChemStation, data might be lost.
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Alternatively, you can open the Data Cleanup dialog at any time with the Cleanup 
Data command in the ECM or Data Store menu. This dialog box lists all data sets 
that are also kept in the central data storage system apart from the currently 
loaded data. The following columns are available:

• Directory: Location of the local file

• ECM Information or Data Store Information: Server of the central data storage 
system and path for the file in the central repository. For ECM, also the 
ECM Account is shown.

• Last Modified: Date/Time when the file in the central repository was last 
changed

• Locally Modified: Information whether the local copy has been modified

• Local Version: ECM or Data Store version that was downloaded to the local 
directory

You can now manually select the data sets to be deleted from the local disk.

Alternatively, via a drop down list you can deselect all data sets, select all data 
sets, select only single runs, select only result sets, select items older than one 
day, or items older than a week.

After pressing OK, the local copies of the selected data sets are deleted.

Both automatic cleanup on shutdown and manual cleanup are only possible if 
the following conditions are fulfilled:

• the ChemStation user is logged on to the central data storage system

• no other instance of the ChemStation instrument is open

• the queue in the Queue Management is empty

If one of these conditions is not fulfilled, automatic cleanup will not be 
performed and it is not possible to open the Data Cleanup dialog.

NOTE Consider selecting the Cleanup Data on Shutdown check box when the system shall be 
compliant to 21 CFR Part 11. Using this function prevents unauthorized access to the local 
data files.
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Queue Management

The Queue Management dialog is opened via ECM > Manage Queue ... or Data Store 
> Manage Queue ... respectively. If you selected the check box Manage Queue on 
Connect, and there are interrupted transfers, the dialog is also opened when 
you start ChemStation.

With this dialog, you can manage the data transfers from ChemStation to the 
central data storage that were interrupted or could not be started for any 
reason. Each failed transfer job is listed in a separate line.

Figure 7 Queue Management

The following information is provided for each line:

• Description: Information on the version of the data that will be transferred. 
Two values are possible:

• Import: No older version of the data exists in the central data storage 
system at this time. The data has been newly created and will be 
uploaded as Version 1. 

• Commit: There is already at least one version of the data in the central 
data storage system. The version number of the uploaded data will be 
increased by one.
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• Error: Error that disrupted the data transfer. For details on the possible 
errors, see “Error Messages in the Queue Management” on page 115.

• Queued at: Date when the unsuccessful transfer was queued.

• Last process at: Date when the transfer was last attempted.

The toolbar offers you the following commands to manage the queue:

When items are selected from the queue or saved to the local disk, an audit 
trail entry will be added to the Audit Trail of the central data storage system.

Table 2 Queue management toolbar

Icon Tooltip Description

Process queue Continue processing the transfer jobs. As long as there 
is no error, all pending transfer jobs will be processed 
in the order as they are shown in the list. This function 
is only active if you select the first line in the list. 

Stop processing Stop processing the transfer jobs.

Save selected item locally Save the data of the corresponding item to the file 
system.

Delete selected item Delete the selected transfer job from the queue. The 
concerned data will not be transferred.

Properties Display the Queue Management dialog box, which 
shows details of the items in the queue in either 
summary or detailed form.

Refresh view Update the display of the items in the list.

NOTE When items are deleted from the queue or information on a failed transfer is saved to the 
local disk, the items have not yet been uploaded to the central data storage system.
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Queue Management Details Dialog Box

The Queue Management Details dialog box is displayed when you click the  
tool in the toolbar of the Queue Management dialog box. It shows the 
command-specific details of the commands in the Queue Management dialog 
box. The Queue Management Details tabs offer two views of the command 
details:

• Summary tab

• Details tab

In either tab, the tools in the toolbar allow you to navigate through the 
command details: 

Summary tab

The Summary tab gives the following summary information about the selected 
item:

Displays the details of the first command in the list.

Displays the details of previous command in the list.

Displays the details of next command in the list.

Displays the details of last command in the list.

Command Description The description of the item.

 Created The date and time when the item was added to the queue.

Changed The date and time when the item was last processed.

Last Error A description of the error that caused the item to be added to the queue.
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Details tab

The Details tab gives detailed information about the selected item. You cannot 
edit the information in this list. The toolbar provides the following tools:

Sorts the properties by category.

Sorts the properties alphanumerically.
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Remote Data Path as Sequence Parameter

Instead of specifying the remote data path in the Preferences for all acquisition 
sequences to be run (see “Remote Data Path” on page 31), the remote data 
path can also be set directly in the sequence template. This allows to set up 
different remote paths for each sequence without having to modify the 
Preferences. The Path for a sequence template is set up in the Sequence 
Parameters tab.

Figure 8 Sequence Parameters tab of the Sequence Parameters dialog

Use Preferences: When this check box is selected, the remote data path as 
specified in the Preferences will be used. Any path specified in the Sequence 
Parameters will be ignored for this sequence. When this check box is cleared, 
the remote data path will be used as specified when the sequence template is 
used for data acquisition. 
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Path: To specify the remote data path, you need to select a folder path available 
in the central data storage system. Click the button with the three dots [ ] to 

select the required path. Alternatively, you can click the arrow [ ] to select 
one of the predefined tokens for an automatic path creation. With these 
tokens, the system automatically creates the items if they do not already exist 
in the central data storage system.

NOTE In ECM, there are separate privileges to create content and create folders. If you use 
tokens, make sure you have the required privileges in ECM to create folders! Alternatively, 
another user who has the required privileges can create the necessary folders in advance.
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Compressed ChemStation File Formats

When ChemStation data is uploaded to the central repository, the data is 
automatically packaged into an SSIzip file. Depending on the type of data, 
different packaging formats are used. 

The packaging of ChemStation data is part of OpenLAB CDS ChemStation 
Edition and cannot be changed manually.

The packaging is automatically carried out when the data is uploaded to the 
central repository. When the SSIZIP files are downloaded from the central 
repository to ChemStation, they are automatically unpacked into the 
corresponding directory in the ChemStation Explorer.

ChemStation data Packaging format Icon in 
ChemStation

Single Runs
(containing *.d file, *.rdl files, and DA.M) 

*.D.SSIZIP

Result set
The result set contains recursively the whole 
sequence data stored in the sequence 
subdirectory:
• all *.d files along with DA.M
• all methods *.m used during acquisition
• batch file *.b
• sequence logbook file *.log
• all *.rdl files used for sequence summary 

reports and single injection reports

*.SC.SSIZIP

Methods *.M.SSIZIP

Sequence templates *.S
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This chapter describes the basic workflows for ChemStation with a central data 
storage system. There are four data-related workflows and two workflows for 
methods, sequence templates, or report templates.
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Transferring Data to or from the Central Repository

You can open and save different ChemStation items into their ChemStation 
contexts:

• Methods

• Sequence templates and Easy Sequence templates

• Report templates for Classic or Intelligent Reporting

• Single run data 

• Sequence data

• Library files

• Column databases

Methods, single run data and sequence data are stored in the central 
repository as SSIZIP file (see “Compressed ChemStation File Formats” on 
page 43).

When the data is uploaded to the central data storage, local copies of the files 
still remain in the ChemStation file system. If an item is loaded from the 
central data storage back into ChemStation, it is automatically loaded into its 
original location.

Different options are available regarding the automatic upload of single 
run/sequence data. This is in contrast to downloading stored data from the 
central repository to ChemStation, which always requires a manual load 
action. Methods, sequence templates and report templates always require a 
manual upload to the central data storage as well as a manual download to 
ChemStation.
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For downloading data from the central data storage, several load commands 
are available in the ECM or Data Store menu. Depending on the current view, 
you can load different files. In the Data Analysis view, you can load single run 
data or sequence data. These data are automatically set to the status checked 
out in the central data storage system. The checked out status of a data file is 
visible to another user and prevents him from inadvertently altering a data file 
that has been downloaded to another ChemStation. In the Method and Run 
Control view, you can load methods and sequence templates. These items are 
only retrieved from the central repository, but they are not checked out. If you 
use Intelligent Reporting, you can also download report templates from the 
central data storage in the Report Layout view.

The following workflows are examples that represent typical tasks done with 
ChemStation and central data storage.
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Data-related workflows

Workflow 1: Acquisition and automatic upload

The workflow Acquisition and automatic upload illustrates how raw data is 
uploaded to the central repository directly after the acquisition is finished. 
The raw data is initially stored locally. After completing the acquisition, the 
data is automatically uploaded to the central repository.

Figure 9 Acquisition and automatic upload
48 ChemStation with Central Data Storage Concepts Guide



Working with ChemStation and Central Data Storage 3
Data-related workflows
To save data to the central repository automatically after completion of a 
single run or sequence:

1 Log in to the OpenLAB Control Panel and launch an online ChemStation.

2 Load a sequence template.

Your user name for the central data storage system is automatically 
inserted as operator name into the sequence template.

3 Click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Path: Select the location in the central repository that you want to use for 
the sequence data upload.

• Select the After Acquisition check box.

5 Configure the sequence parameters and the sequence table.

6 Start the acquisition.

While the acquisition is running, the raw data, method definition, and a 
copy of the sequence template are locally stored on the ChemStation 
computer.

After the sequence is finished, all data is automatically uploaded as an 
.SC.SSIZIP file to the central repository to the previously defined remote 
path. The local copy of the data remains on the ChemStation computer. The 
file name of the result set is determined by the settings in the sequence 
template (for more details on the sequence template settings, refer to the 
manual Agilent OpenLAB CDS ChemStation Edition Concepts and 
Workflows). After uploading the result set the sequence icon in the 

ChemStation Navigation Pane changes from  to . The remote path of 
the result set is shown in the ChemStation toolbar.
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NOTE The color of the Sequence Data icon in the Navigation Pane allows to track the 
modification status of the data:

: The result set is stored in the central repository and has not been modified locally

: The result set is stored in the central repository and has been modified locally

NOTE The upload process may take some time when large amounts of data are uploaded. During 
this time ChemStation is busy and the user cannot perform tasks in ChemStation. Please 
wait until the upload is completed.
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Workflow 2: Offline review during acquisition

The workflow Offline revision during acquisition illustrates how raw data is 
reviewed while the acquisition is still running. Directly after the acquisition is 
finished, the original raw data is automatically uploaded to the central 
repository. After the review, the changed data is again uploaded to the central 
repository. When the data is uploaded the second time, a new version is 
created.

Figure 10 Offline review during acquisition
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To save data to the central repository automatically after modification:

1 Log in to the OpenLAB Control Panel and launch an online ChemStation.

2 Load a sequence template.

Your user name for the central data storage system is automatically 
inserted as operator name into the sequence template.

3 Click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Path: Select the storage location that you want to use for the sequence 
data upload.

• Select the After Acquisition check box.

• Select the After Any Data Modification check box.

5 Start the acquisition.

While the acquisition is running, the raw data, method definition, and a 
copy of the sequence template are stored locally on the ChemStation 
computer.

6 Open an offline ChemStation and change some data analysis parameters for 
one of the already finished samples. Save your changes locally.

7 After the acquisition has finished, two things will happen:

• The original raw data is automatically uploaded as an .SC.SSIZIP file, 
Version 1, to the central repository using the previously defined remote 
data path. The path of the new sequence is shown in the toolbar in the 
online ChemStation.

The file name of the result set is determined by the settings in the 
sequence template (for more details on the sequence template settings 
refer to the manual Agilent OpenLAB CDS ChemStation Edition 
Concepts and Workflows).

The sequence icon in the ChemStation Navigation Pane changes from  

to .

• An Upload dialog opens in the online ChemStation. Click OK to confirm 
that you finished all work in the offline instance. As soon as you confirm 
this dialog, the changed data is uploaded as Version 2 to the central 
repository.

A local copy of the changed data remains on the ChemStation computer. 
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NOTE For both versions (the one after acquisition and the one from the parallel offline review) the 
ChemStation operator is the user who has run the acquisition, even if another user has 
performed the review in the Offline ChemStation.
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Workflow 3: Reprocessing data and automatic upload

The workflow Reprocessing data and automatic upload illustrates how data 
is reprocessed and then automatically uploaded. This workflow applies to data 
that has been previously stored in the central repository. A new version of the 
data is created in the central repository for the reprocessed or changed data.

Figure 11 Reprocessing data and automatic upload
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To save data to the central repository automatically after reprocessing:

1 Log in to OpenLAB Control Panel and launch an online or offline 
ChemStation.

2 Select ECM > Load Data or Data Store > Load Data to download a sequence from 
the central repository.

A dialog opens where you can select the required data. Navigate to the 
folder that contains your data and select one of the following packaged files:

• Single run data: *.D.SSIZIP files

• sequence data: *.SC.SSIZIP files

Figure 12 ECM Desktop Open dialog

If the item is checked out, it is marked with a blue or red icon (see 
marker 1):

 (blue icon): the item has been checked out by you (current user)

 (red icon): the item has been checked out by another user

You can load any checked out item. However, if an item has been checked 
out by another user, the other user must check in the item before you can 
save it back to the central repository.

To check out or check in an item, you can use the respective icons available 
in the dialog (see Figure 12 on page 55, marker 2). You can only check out 
the latest version of an item.
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In order to see more details regarding the type and version of the available 
items, select the Detail view (see Figure 12 on page 55, marker 3). To open 
an older version of an item, select the Open Revisions command from the 
Open menu (see Figure 13 on page 56). This opens the File Versions dialog, 
where all available versions of the item are listed (see Figure 14 on 
page 56).

Figure 13 Open Revisions command

Figure 14 File versions dialog

3 Select Open in either dialog to download the item to ChemStation. 

If the item was not already checked out, it is automatically checked out of 
the central repository when you load it to ChemStation.

The remote data path is shown in the ChemStation toolbar.

4 In the Data Analysis view, click View > Preferences.

5 On the Transfer Settings tab, configure the following settings:

• Select the After Reprocessing check box.

• Select the After Any Data Modification check box.

6 Modify or reprocess the sequence data.

After the reprocessing is finished, the sequence data is uploaded with its 
original name to its original remote data path. The version number is 
increased by one.
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The local copy of the reprocessed data remains on the local file system of 
the ChemStation computer.

Workflow 4: Import after reprocessing

Figure 15 Import after reprocessing

The workflow Import after reprocessing illustrates how locally saved data is 
reprocessed and then automatically imported into the central repository. 
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To save data to the central repository automatically after reprocessing:

1 Log in to OpenLAB Control Panel and launch an offline ChemStation.

2 From the local file system, open a sequence that has never been saved to the 
central repository before.

3 In the Data Analysis view, click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Path: Select the storage location that you want to use for the sequence 
data upload.

• Select the Import after Reprocessing check box.

5 Reprocess the sequence data.

The sequence data is uploaded as a new .SC.SSIZIP file, version 1, to the 
previously defined remote data path in the central repository. The file name of 
the result set is determined by the settings in the sequence template (for more 
details about the sequence template settings refer to the manual Agilent 
OpenLAB CDS ChemStation Edition Concepts and Workflows).

The sequence icon in the ChemStation Navigation Pane changes from  to .

The local copy of the reprocessed data remains on the local file system of the 
ChemStation computer.

NOTE The data will not be uploaded if you only modify it. You need to reprocess the sequence 
data.
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Workflows for Methods and Templates

The following workflows are applicable to methods and sequence templates. If 
you enabled Intelligent Reporting in Instrument Configuration in the 
OpenLAB Control Panel, these workflows also apply to report templates. The 
diagrams show the workflows using methods as an example.
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Workflow 1: Save new method

The workflow Save new method illustrates how newly created or locally stored 
methods or sequence template can be manually uploaded to the central 
repository.

Figure 16 Save new method, sequence template, or report template
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To upload a new method, sequence template, or report template:

1 Log in to OpenLAB Control Panel and launch an offline ChemStation.

2 In ChemStation, load the method/sequence template/report template or 
create a new one.

3 Select the appropriate Save command from the ECM or Data Store menu.

In the Method and Run Control view:

• Save Method

• Save Sequence Template

In the Report Layout view (only with Intelligent Reporting):

• Save Report Template

4 In the Save dialog, navigate to the remote data path of your choice to upload 
the method/sequence template/report template. 

In ECM, you can only upload items into a Folder, not into a Location, 
Cabinet, or Drawer. In Data Store, you can select any path.

5 If necessary, save the item using a different name. The original name is used 
by default, but you can modify the name.

6 Click Save.

The Add File dialog opens. 

7 Enter a reason for the upload and click OK. The reason is then shown in the 
Audit Trail of the central data storage system (see “Audit Trail of the 
Central Data Storage” on page 77).

The progress of the upload is displayed in a window until the item is 
uploaded to Data Store. 

After finishing the upload, the SSIZIP file is available in the central 
repository as version 1. The file is saved to the remote data path defined in 
the Preferences (see “Remote Data Path” on page 31). 

The method icon in the ChemStation Navigation Pane changes from  to 

.

The icon for a sequence template changes from  to .

The icon for report templates changes from  to 
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Workflow 2: Save changed method

Figure 17 Save changed method
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The workflow Save changed method illustrates how methods, sequence 
templates, or report templates that are already stored in the central 
repository are edited and saved under the same name as a new version.

1 Log in to OpenLAB Control Panel and launch an online or offline 
ChemStation.

2 Load a method, sequence template, or report template.

• Open a method/sequence template/report template from your local PC. 
Choose an item that has been uploaded to the central repository before. 

Methods are indicated by , sequence templates by , and report 

templates by  in the ChemStation Navigation Pane.

– or –

• Select the Load Method, Load Sequence Template, or Load Report Template 
commands in the ECM or Data Store menu to download an item from the 
central repository.

If you use one of the Load commands, a dialog will open where you can 
select the required data. Navigate to the folder to load the method 
(*.M.SSIZIP), sequence template (*.S or *.S.SSIZIP), or report template 
(*.RDL) of your choice.

Figure 18 ECM Desktop Open dialog
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If the item is checked out, it is marked with a blue or red icon (see Figure 18 
on page 63, marker 1):

•  (blue icon): the item has been checked out by you (current user)

•  (red icon): the item has been checked out by another user

You can load any checked out item. However, if an item has been checked 
out by another user, the other user must check in the item before you can 
save it back to the central repository.

To check out or check in an item, you can use the respective icons available 
in the Open dialog (see Figure 18 on page 63, marker 2). Using these icons, 
you can only check out the latest version of an item.

In order to see more details regarding the type and version of the available 
items, select the Detail view (see Figure 18 on page 63, marker 3). To open 
an older version of an item, select the Open Revisions command from the 
Open menu (see Figure 19 on page 64, marker 1). This opens the File Versions 
dialog, where all available versions of the item are listed (see Figure 20 on 
page 64).

Figure 19 Open Revisions command

Figure 20 File versions dialog
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3 Select Open in either dialog to download the item to ChemStation. In order 
to prevent other users from modifying the item, it is possible to select the 
Open As Checked Out command to mark the item as checked out in the central 
data storage system (see Figure 19 on page 64, marker 2).

If the file already exists on the ChemStation computer in the specified 
location, you must choose a different download location.

The remote path of methods and templates is shown in the ChemStation 
toolbar.

4 Make the required changes to the loaded item.

A modified method is indicated by  in the navigation pane.

A modified sequence template is indicated by .

A modified report template is indicated by .

5 Select the appropriate Save command in the ECM or Data Store menu to save 
the changed item.:

• Save Method

• Save Sequence Template

• Save Report Template

NOTE Unlike data files, the methods, sequence templates, and report templates are not 
automatically checked out of the central data storage system! In order to modify those 
items in ChemStation, you should check them out manually. Otherwise, there is no 
guarantee that you are working on the latest version.

NOTE If you have not checked out the item before loading it from the central data storage, and 
another user has checked out the item in the meantime, you cannot proceed with the 
upload back to the central data storage. A warning message is displayed, and it is not 
possible to save the item until the other user has released the checked out item.
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6 When the Add File dialog opens, enter a reason for the upload and click OK. 
The reason is then shown in the Audit Trail of the central data storage 
system (see “Audit Trail of the Central Data Storage” on page 77).

The progress of the upload is displayed in a window until the item is 
uploaded to the central repository.

The .M.SSIZIP/.S/.RDL file is uploaded with its original name to its original 
remote data path (the path is shown as a tooltip of the method/sequence 
template/report template in ChemStation). The version number is 
automatically increased by one.
66 ChemStation with Central Data Storage Concepts Guide



Working with ChemStation and Central Data Storage 3
Workflows for Methods and Templates
Updating the Local Master Method, Sequence Template, or Report 
Template

If a master method, sequence template, or report template is updated in the 
central data storage system (i.e. a new version is created), it is possible to 
update the local copy with the following update procedure.

1 Make sure the master method, sequence template, or report template to be 
updated is currently not loaded. A currently loaded item is not available for 
update.

2 Select the appropriate Update command from the ECM or Data Store menu:

• Update Methods ...

• Update Sequence Templates ...

• Update Report Templates ...

Figure 21 Update Methods dialog box

A dialog box is displayed where you can select the items to be updated.

The dialog box lists all items that have previously been uploaded to the 
central data storage. The following columns are available:

• Name: Path and Name of the local copy of the method, sequence template, 
or report template.

• ECM Information/Data Store Information: Server of the central data storage 
system and path of the file in the central repository; for ECM, also the 
ECM Account is shown.
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• Locally Modified: A check box indicating whether the local copy was 
modified.

• Local Version: Version number of the local copy of the method, sequence 
template, or report template.

• ECM Version/Data Store Version: Version number of the file in the central 
repository.

3 You can now manually select the items that are to be updated. Alternatively 
you can use the drop down list to deselect all items, select those items with 
a higher version number in the central repository, or select all items that 
have been modified locally. 

After clicking OK, the selected local items are updated with the version from 
the central data storage.
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This chapter explains the purpose of 21 CFR Part 11 and how the integration of 
ChemStation with a central data storage system addresses the requirements of 
21 CFR Part 11.
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Introduction to 21 CFR Part 11

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-trail 
documentation into electronic records. This rule is known as 21 Code of 
Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all 
industry segments regulated by the FDA.

The impact of this rule on current work practices and data handling in the 
pharmaceutical industry has been much higher than expected. “The industry 
wanted to have a rule on electronic signatures, but what they got was a rule 
on electronic records.” (Martin Browning, former FDA inspector, during a 
validation seminar in Washington D.C.)

21 CFR Part 11 places high emphasis on the implementation of all measures to 
protect and secure electronic records. Notwithstanding the uncertainties and 
the changes that 21 CFR Part 11 requires in the behavior of both the 
pharmaceutical industry and the vendors of chemical analysis equipment, it is 
well worth implementing in today’s laboratories because it can help the 
industry with one of the most important issues in pharmaceutical 
research-bringing new drugs on the market faster.

The major benefits of this shift towards electronic data management are in the 
potential productivity increase for the industry. The industry can decrease its 
data output on paper, speed up the data review and approval process, and 
benefit from new automation technology based on computerized system 
control, for example, in manufacturing or dissolution drug release testing.

In addition to this rule on electronic records, other general requirements for 
computerized systems are brought to the auditor’s attention. These rules cover 
the basic requirements of validation which are limiting data access and 
ensuring data integrity and data traceability. 

It is, of course, the industry that must ensure that its work practices support 
the FDA rules, but most of the requirements also affect the chemical analysis 
systems and suppliers of these systems.
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21 CFR Part 11 Requirements

To fulfill the FDA rules and guidelines for compliant electronic records and 
computerized systems, it is important to understand the basic aspects of 
secure data handling.

• Data security: physical protection of data by limiting access to the system 
and preventing unauthorized access.

• Data integrity: protecting raw data and metadata and preventing these 
from unauthorized modification, and linking raw data and results to 
reproduce the original results at any time, for example, in an audit 
situation, and document each new result copy.

• Audit traceability: documenting who did what to the results and when, and 
tracing the user adding new reanalyzed versions to the original raw data.

General Aspects of Data Security in Computerized Networks - Open 
Versus Closed Systems

Before discussing details of data security in a chromatographic system, some 
general aspects of data security in a computerized network need to be 
considered.

It is generally known that data transfer over a public network can be accessed 
by unauthorized external persons, "hackers", who gain access either for 
personal amusement or intentional fraud. 

If an electronic identification comprising user ID and a password is used to 
approve confidential or important data, users must be sure that their 
signatures are unbreakably linked to the data and that nobody can copy this 
signature or get access to the passwords. In a public system, this would 
require additional encryption technology, for example, a private/public key 
combination of data encryption. In contrast, if a computerized system is 
protected from unauthorized access, users can be sure that their signatures 
are private and are not accessible to unauthorized individuals.

The FDA also distinguishes between these two scenarios and defines them as 
open and closed systems. A public network system can therefore only be 
viewed as an open system and a protected network as a closed system, if it 
fulfills additional requirements.
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In FDA terms, "closed system means an environment in which access is 
controlled by persons who are responsible for the content of electronic 
records on the system" (11.3.5). The evidence of a system being a closed 
system is not a one-time check but an ongoing process of executing and 
documenting the system controls that make sure that the system is closed. In 
contrast, in an open system, "those persons being responsible for the content 
of electronic records do not control the system access."

As a result, open systems require additional encryption technology for all data 
transfer over the network.

Agilent OpenLAB CDS is designed for and supported in closed systems.
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Overview of Configuration Steps Required for Part 11

If you want to configure OpenLAB CDS ChemStation Edition with a central 
data storage system to be compliant with 21 CFR Part 11, you need to go 
through the following checklist:

• Directory structure in the central data storage system prepared according 
to your needs

See “Storage Model in OpenLAB ECM and OpenLAB Data Store” on 
page 17.

• Roles/Users/Groups configured in the central data storage system and in 
OpenLAB Control Panel

See “Users, Roles, and Privileges Concept with ECM” on page 93.

• Configuration of the central data storage system with active audit trail and 
mandatory reason

See “To Enable the Data Store Audit Trail” on page 77.

See “To configure Data Store” on page 84.

• Password policy realized in OpenLAB Control Panel (including E-mail 
Notification)

See “To configure password settings in Data Store” on page 86.

• E-Signatures prepared (messages and privileges)

See “Using electronic signatures” on page 103.

• Automatic Data Transfer Settings and Transfer Management Settings 
activated

See “Automatic Data Transfer Settings” on page 33.

• Audit trail active for methods and results

See “Method Audit Trail” on page 74 and “Results Audit Trail” on page 76.

• Emergency Plan available, based on options of the Administration Tool

See “ChemStation Administration Tool” on page 96.
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Audit Trails and Logbooks

In order to comply to 21 CRF Part 11, ChemStation Edition offers various 
audit trails and logbooks to document all activities associated with methods, 
results, reports, or any files stored in the central repository. These audit trails 
and logbooks track all changes that are made to any file, including data 
acquisition, re-analysis, and long-term archiving.

The audit trails are stored in separate files, which are stored together with the 
sample or method data. The audit trail files are archived together with the 
other data in the respective SSIZIP files. The logbooks are available only in the 
central data storage system.

Method Audit Trail

Each method has a Method Audit Trail. By default, this Method Audit Trail 
contains only the comments that you must provide each time when you save a 
method. As there is no control on the provided text, there is no guarantee that 
the method changes are reproducible.

With regards to 21 CFR Part 11, OpenLAB CDS ChemStation Edition makes it 
possible to generate a more detailed Method Audit Trail. If the function is 
activated, the Method Audit Trail contains not only the user comments, but 
also each individual changed parameter with its old and new value. All 
changeable data analysis parameters are tracked. This means that you can 
reproduce exactly which value has been changed to what, when, and by whom.

Depending on the instrument driver, the Method Audit Trail may also contain 
an entry for each changed instrument setting. This feature is supported, for 
example, by Agilent LC System RC.Net drivers and Agilent GC 7890 System 
drivers.
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To enable the Method Audit Trail for all methods

This is required if you want to comply to 21 CFR Part 11.

1 Select View > Preferences

2 In the Audit Trail Status dialog, select Enable Audit Trail for all methods, and click 
OK.

Once enabled, the Method Audit Trail cannot be disabled.

To enable the Method Audit Trail only for the currently open method

You can also activate the Method Audit Trail only for one method. This might 
be useful, for example, when you finished the development of new method and 
want to track all further changes.

1 Select Method > Enable Audit Trail

2 On the Audit Trail tab, select Enable Method Audit Trail for this method.

To view the Method Audit Trail for the currently open method in 
ChemStation

1 Select Method > Method Audit Trail.

To create a new method without a detailed Method Audit Trail

Once a method is enabled for the detailed audit trail, you cannot disable it 
again. You can only save the method under a different method name. The new 
Audit Trail of the new method will then contain a comment about the method 
being based on the existing method.

NOTE You can also use the ChemStation Administration Tool to enable the Method Audit Trail for 
all methods (see “ChemStation Administration Tool” on page 96).
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Results Audit Trail

Manual integration events are not saved in the method. Therefore, the Method 
Audit Trail contains no information on manual integration events. These 
events are only saved in the data file. Nevertheless, they have an influence on 
the results. Manual integration events are therefore saved as part of the 
Results Audit Trail.

If activated, this Results Audit Trail is added to the existing Data File Logbook 
(file name RUN.LOG). By default, the Data File Logbook only contains the 
acquisition parameters and reprocessing information for each sample. The 
Results Audit Trail additionally tracks the changes of all data analysis 
parameters for a sample. 

To enable the Results Audit Trail

If you enable the Results Audit Trail, the relevant changes are tracked for all 
samples, independent of the sequence they belong to and independent of the 
user who carries out the change.

1 Select View > Preferences

2 On the Audit Trail tab, select Enable Results Audit Trail.

To view the Results Audit Trail for the loaded sample in ChemStation

1 In the Data Analysis view, select View > Current Data File Logbook.

Report History

If you create a ChemStation report, you can display the report on the screen, 
send it to a printer, or save the report as a specific file (report.pdf). These 
report outputs may easily be lost or overwritten, especially when you create 
several reports one after another.

ChemStation automatically tracks all reports that have been generated. In 
order to reproduce an old or overwritten report, select Report > Report History. 
Here, you can see all reports created for the current data file. You can also 
export or print this history.
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Audit Trail of the Central Data Storage

The Audit Trail of the central data storage system is a record showing who 
accessed the system and what operations he or she performed during a given 
period of time.

You can view file-related, system administration, folder administration, and 
(for ECM) scheduler-related entries. For example, you can see when a file was 
added and who added it.

For each operation, the central data storage system asks the user for a reason. 
This reason is also shown in the Audit Trail. For automatic uploads there are 
default reasons given by the system.

To enable the ECM Audit Trail

You can enable the ECM Audit Trail only for a complete ECM Account. To 
activate the ECM Audit Trail, you must select the check box Enable audit trail for 
this account when creating a new account.

There is no possibility to activate the ECM Audit Trail afterwards for an 
existing account, or to deactivate the ECM Audit Trail again.

To Enable the Data Store Audit Trail

In Data Store, you do not need to manually enable the Audit Trail. It is always 
enabled.

NOTE In ECM, you must manually enable the Audit Trail. The entry of a reason for the audit trail 
can be set to be optional or mandatory. If the system shall be compliant to 21 CFR Part 11, 
the ECM Audit Trail must be enabled, and providing a reason must be mandatory (see “To 
configure the ECM Account” on page 82). With Data Store, this Audit Trail is always 
enabled. Using a reason must be regulated by a Standard Operating Procedure (SOP).
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To view the Audit Trail for a specific file in ChemStation

For both ECM and Data Store, you can view the Audit Trail for a specific file 
directly in ChemStation.

1 In the ChemStation Explorer, right-click the respective file.

2 Select ECM Properties... or Data Store Properties... from the context menu.

This command is only available if the file has been uploaded to central data 
storage.

3 In the File Properties dialog, select the Audit Trail tab.

This tab contains all Audit Trail entries associated with the file.

To view the Audit Trail for a specific file in ECM

1 In ECM, right-click the respective file and select Properties from the context 
menu.

2 In the File Properties dialog, select the Audit Trail tab.

All actions related to this specific file are listed here, together with the 
date, ECM user name who performed the action, and a reason provided by 
the according user. 

To view the Audit Trail for a specific file in Data Store 

1 In Data Store, navigate to the respective file and click the Properties icon  
of this file.

A file preview is shown, together with several document properties and a 
list of document actions.

2 Under Document Actions, click Audit trail.
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To view the Audit Trail for all files in ECM

1 In ECM, select the Administration page.

2 In the Navigation Pane, select the Activity Log > Audit Trail node.

All actions related to any ECM file are listed here, together with the file 
name, date, ECM user name who performed the action, and a reason 
provided by the respective user. 

You can search the entries, for example, for a specific date or date range, or 
for entries related to specific categories (Files, Folders, System, Scheduler, 
or Instrument). Also you can print the entries or export them to a file.

To view the Audit Trail for all files in Data Store

1 In Data Store, select Tools > View Audit Trail in the left pane.

You can filter the list by date range and user name.

NOTE The user name is case sensitive and needs to be an exact match.
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System Log of the Central Data Storage

The System Log of the central data storage is a record that shows changes to 
the system, including configuration changes, e-mail notifications, and 
additions or changes to the directory structure.

You can view file-related, system administration, folder administration, or (for 
ECM) Scheduler-related entries. For example, you can see when a directory 
was added and by whom.

The System Log is always active; you do not need to enable it.

To view the ECM System Log

1 In ECM, select the Administration page.

2 In the navigation pane, select the Activity Log > System Log node.

All general actions related to ECM are listed here, together with the date, 
ECM user name who performed the action, and a reason provided by the 
respective user. Depending on the ECM Account administration, the reason 
may be optional or mandatory (see “To configure the ECM Account” on 
page 82).

You can search the entries, for example, for a specific date or date range, or 
for entries related to specific categories (Files, Folders, System, Scheduler, 
or Instrument). Also you can print the entries or export them to a file.

To view the Data Store System Log

In Data Store, there is only one single activity log for the entire system. System 
activities are stored at the same place as file activities.

1 In Data Store, select Tools > View Audit Trail in the left pane.

You can filter the list by date range and user name.

NOTE The user name is case sensitive and needs to be an exact match.
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System Activity Log in OpenLAB Control Panel

The System Activity Log allows you to centrally access all system activities. It 
contains information on the various events associated with OpenLAB Shared 
Services or with specific instruments. You can filter the list in order to view 
only events of a specific type, in a specific time range, created by a specific 
user, or containing a specific description.

The following types of events are recorded:

• System

• Instrument Management

• Instrument

• Project Management (only applicable to EZChrom)

• Instrument Controller

• User

• Group

• Security

• Printer

• License

The messages can come from other components, such as the user management, 
or from an instrument module. Instrument messages include error messages, 
system messages or event messages. ChemStation records these events in its 
own environment but also sends the events to the System Activity Log. The 
System Activity Log records these events irrespective of whether you have 
been alerted to them or not. To get more information on an event, expand the 
line of interest in the activity logbook viewer.

NOTE By default, activity logging is disabled. To enable it in OpenLAB Control Panel, you must 
have the Edit activity log properties privilege. Once enabled, activity logging cannot be 
disabled again.
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Security Policy

21 CFR Part 11 requires that the company or laboratory have a security policy 
in place to ensure that only authorized users access the data.

Configuration of the Central Data Storage System

To configure the ECM Account

1 In ECM, select the Administration page.

2 In the Navigation Pane, select the Account Administration node.

3 Double-click the Configuration item. 

The Account Administration dialog opens.
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Table 3 Settings in ECM Account Administration

Setting Description 21 CFR Part 11 Requirements

Lockout If a user tries too often to log in with 
invalid user credentials, he is locked 
out of the system and cannot log in any 
more – not even with valid user 
credentials. You can define the number 
of allowed login attempts.
This setting only applies to ECM built-in 
users, not to Windows domain users.

You should limit the number of 
allowed login attempts to 
three.

Inactivity Timeout If a user does not perform any action for 
the given period of time, he is 
automatically logged out of the ECM 
Web Client.
Note: The inactivity timeout of 
ChemStation is set in the Security 
Policy area of the OpenLAB Control 
Panel.

You should specify a timeout.

System 
administrator email

The e-mail address you provide here 
will automatically be notified when a 
user was locked out after too many 
unsuccessful login attempts.

You should provide an e-mail 
address.

Minimum Password 
Length

If users change their passwords, they 
must choose a password with at least 
the given number of characters. The 
default setting is 5.
This setting only applies to ECM built-in 
users, not to Windows domain users.

You should require a minimum 
password length of at least 5 
characters.

Require entry in 
Reason fields

In each ECM Audit Trail or System Log 
entry the users can enter a specific 
reason for the action. If this check box 
is selected, the entry is mandatory.

The ECM Audit Trail and 
System Log reasons must be 
mandatory.
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To configure Data Store

1 In the OpenLAB Control Panel, select Administration > Security Policy from 
the navigation pane.

Table 4 Security Policy settings

Setting Description 21 CFR Part 11 Requirements

Minimum password length If users change their 
passwords, they must choose 
a password with at least the 
given number of characters. 
The default setting is 5.
Only available for 
authentication provider 
Internal.

You should require a minimum 
password length of at least 5 
characters.

Password expiration period 
(days)

The default value is 30 days. 
When the user tries to log in 
after this period of time, the 
system will ask him to change 
the password. The expiration 
period starts with the last 
password change or with the 
creation of a user with a new 
default password.
Only available for 
authentication provider 
Internal.

You should use an expiration 
period of 180 days or less.

Maximum unsuccessful login 
attempts before locking 
account

If a user tries to log in with 
invalid user credentials a 
number of times, the user is 
locked out of the system for a 
certain period of time 
(Account lock time, see 
below). Login is impossible, 
even with valid user 
credentials. You can define the 
number of allowed login 
attempts. The default setting is 
3.
Only available for 
authentication provider 
Internal.

You should limit the number of 
allowed login attempts to 
three.
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Account lock time (minutes) Once a user has exceeded the 
maximum number of allowed 
unsuccessful login attempts, 
this is the amount of time that 
must pass before he can try 
again. The default setting is 
5 min.
Only available for 
authentication provider 
Internal.

Inactivity time before locking 
the application

If the OpenLAB Control Panel 
is inactive for this amount of 
time, the user interface will be 
locked. This setting is also 
used to set the time-based 
session lock in ChemStation. 
The default setting is 10 min. 
Set the value to zero to never 
lock.

Single Sign-On With Single Sign-On enabled, 
the user will not see the 
OpenLAB Control Panel login 
screen. 
Only available for 
authentication provider 
Windows Domain.

Table 4 Security Policy settings

Setting Description 21 CFR Part 11 Requirements
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User-Specific Settings

21 CFR Part 11 does not define any specific rules for the password settings. 
However, your company must have defined a password policy. 

To configure password settings in ECM

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Users/Groups/Roles item.

You may consider the following settings for ECM built-in users:

• User cannot change password

• User must change password after next login

To configure password settings in Data Store

1 In the OpenLAB Control Panel, select Administration > Users from the 
navigation pane.

2 Select a user, and click Edit in the ribbon.

If the authentication provider is set to Internal, you can configure the 
following settings on the General tab:

NOTE The minimum password length for ECM built-in users is defined in the ECM Account 
configuration (see “To configure the ECM Account” on page 82).
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Table 5 User Credentials

Value Description Mandatory

Name Username to login in to the system. Yes

Description Additional information about the user (e.g. 
department, function etc.)

No

Password Password for the user; minimum password 
length is defined in the Security Policy.

Yes

Email address Email address of the user. No

Full name The full (long) name of the user. No

Contact Information General contact information (e.g. telephone 
number, pager etc.)

No

User disabled Select the check box to disable a user. Disabled 
users cannot log in any more. Users may be 
automatically disabled after too many failed 
login attempts.
If a user is disabled, a corresponding message is 
displayed instead of the check box. After a given 
time (see Account lock time in the Security 
Policy settings), the user is automatically 
enabled again.

No

User cannot change password Flag that indicates whether the user can change 
his own password. The flag is false by default 
(that is, users CAN change their passwords).

No

User must change password at 
next login

If set to true, the user has to change his 
password at the next login. The flag is 
automatically set to false after the user has 
changed the password successfully. The flag is 
true by default for new users.

No

Group Membership Assign the user to the relevant groups.

Role Membership Assign roles directly to the user.
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Users/Groups/Roles Configuration

Users with specific roles and privileges are needed in both the central data 
storage system and in ChemStation. First, you need to authenticate with a 
user name and password when you start ChemStation from the OpenLAB 
Control Panel. Then, additional privileges are required for specific functions 
in ChemStation as well as in the central data storage system.

In OpenLAB CDS, user management is part of OpenLAB Shared Services, 
which you access via the OpenLAB Control Panel. Each user can be member of 
specific groups. To each group, you can assign predefined roles that comprise 
specific privileges. If you use an external authentication provider, you can 
import users and groups from the external system.

Settings in OpenLAB Control Panel

Users in OpenLAB Control Panel

If you use an external authentication provider such as ECM, you cannot create 
new users, but must import users that exist in the authentication systems. A 
search function helps you find specific users in the authentication system. In 
the OpenLAB Control Panel, you can manage the roles for those external 
users, but not the actual user credentials such as user name and password. If 
you want to remove an external user, you unmap the user in the OpenLAB 
Control Panel. The user continues to exist in the external authentication 
system.
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Groups

If you use an external authentication provider, you can either import the 
names of groups that exist in the external system or create new internal 
groups. There is no limit on the number of groups that can be mapped or 
created.

You can assign users to groups in the external system or in OpenLAB Control 
Panel. If you need additional user assignments that are relevant only for 
OpenLAB CDS, you create them in OpenLAB Control Panel. Otherwise it is 
sufficient to only import the groups and assign the required roles to the 
groups.

If you delete or unmap a group, the users who where members in this group 
remain unchanged.

Roles and Privileges in OpenLAB Control Panel

Roles are used to assign privileges to a user or a user group globally or for a 
specific instrument or location. The system contains a list of predefined roles 
which are installed as part of the system installation (for example, Instrument 
Administrator, Instrument User, or Everything). Each role has certain privileges 
assigned.

Privileges are grouped according to the three main role types (Project role, 
Instrument role, and Administrative role). When you assign privileges to a 
role, you first select the required role type and then select the privileges 
related to this role type. Each role can only have privileges of one specific role 
type; the only exception is the predefined role Everything, which has all 
privileges of all role types. Users or groups may require multiple roles to 
perform system functions. For example, a user with the role ChemStation 
Operator will always need another role such as Instrument User with the 
privilege to run an instrument.

You can create a tree of different locations in the OpenLAB Control Panel, and 
add instruments to the relevant locations. For each instrument or instrument 
group, you can assign different Instrument roles (see also “Specific Privileges 
for Individual Locations or Instruments” on page 92). For example, a user can 
have the role Instrument Administrator for one instrument, and Instrument User for 
another instrument.

You can also create a tree of different projects or project groups in the 
OpenLAB Control Panel. With EZChrom, you can assign different Project roles 
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for different projects (see also “Specific Privileges for Individual Locations or 
Instruments” on page 92). For example, a user can have the role Project 
Administrator in one project, so that he can manage the settings in the 
OpenLAB Control Panel. In a second project, he may have a role that allows 
him to edit the content of a project, but not to change the project settings. As 
ChemStation does not yet support projects, you can assign the project roles 
only globally for ChemStation, not at a project level.

For a detailed list of privileges, see Appendix.

Table 6 Description of role types

Role Type Description

Administrative privileges These privileges are globally assigned to a user or group and cannot be 
changed on the instrument/location level. They are the typical 
administration privileges such as Backup and restore, Manage 
security, Manage printers etc. 

Instrument privileges These privileges can be assigned globally or on the 
instrument/location level. Privileges for instruments are, for example, 
View instrument or location and Run instrument.
Users need the View instrument or location on the global level to see 
the locations and instruments tree in the OpenLAB Control Panel.

Project privileges Privileges for accessing or modifying different levels of data.
• With EZChrom, you can assign these privileges on project level.
• As ChemStation does not yet support projects, these privileges are 

globally assigned to the users with ChemStation.
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Privileges Related to Central Data Storage

The following tables describe the privileges that are relevant for OpenLAB 
Data Store.

Table 7 Administrative privileges

Privilege Name Description

Archive content The role Archivist includes this privilege by 
default.
The user can archive the content of the Data 
Store repository. 

Table 8 Project privileges

Privilege Name Description

View project or project group By default, this privilege is included in the 
Project Administrator role and in all 
ChemStation roles. 
The user can see a project and project details in 
OpenLAB Control Panel, but cannot edit. Also, 
he can view the content of the Data Store 
repository.

Manage project or project group By default, this privilege is included in the 
Project Administrator role.
User can create or edit project properties and 
can move the project but cannot access 
settings (only relevant for EZChrom, as Projects 
are not supported in ChemStation).

Edit content of project By default, this privilege is included in the 
Project Administrator role .
The user can create new versions of documents 
in Data Store. 
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Specific Privileges for Individual Locations or Instruments

By default, the roles of users or groups are globally set for all locations, 
instruments, project groups, or projects. The role settings are inherited from 
the root node Instruments or Projects respectively. In order to assign a different 
role to a user or group for one specific node, you can deselect the Inherit 
privileges from parent check box in the Edit Privileges dialog for the required 
node. Afterwards, you can assign a different role that will be valid only for the 
specific node. 

You can assign Instrument roles to individual locations or instruments. 

You can assign Project roles to individual project groups or projects. As 
ChemStation does not yet support projects, these settings only have an effect 
for EZChrom. 

Administrative roles are always set globally.

Save data to storage By default, this privilege is included in all 
ChemStation roles.
The user can interactively save data to the 
central data storage system.

E-Signature Sign Data Files By default, this privilege is included in the 
Project Administrator role.
The user can sign data files, view and edit 
project properties and create new versions of 
documents in Data Store.

Table 8 Project privileges

Privilege Name Description

NOTE As projects are not yet supported by ChemStation, Project roles are applied globally for 
ChemStation.
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Users, Roles, and Privileges Concept with ECM

With ECM, you must select ECM as an external authentication provider in the 
OpenLAB Control Panel. In ECM itself, you can either set up internal users or 
operate with the Windows users (see ECM documentation). Each user can be 
member of specific groups in ECM and in the OpenLAB Control Panel. The 
groups available in ECM depend on the ECM configuration. The groups 
available in the OpenLAB Control Panel can be imported from ECM and 
supplemented by new internal groups. 

There are several default roles in both ECM and OpenLAB CDS. In both 
systems, you must assign a specific role to each group. Roles and privileges 
must be configured separately for ECM and ChemStation:

• The privileges set in ECM define the accessible content and functions in 
ECM.

• The privileges set in the OpenLAB Control Panel define which functions are 
available in ChemStation, and also which administrative tasks can be 
carried out in the OpenLAB Control Panel.

Default ECM Roles and ECM Privileges

There are a number of default roles and privileges in ECM. The following 
tables show an overview of these roles and privileges.

In addition, you can create your own roles in ECM, or grant further privileges 
to the default roles. For detailed information, refer to the ECM Administrator's 
Guide.

NOTE Once you have created a new ECM user, group, or role, you cannot delete it again. You can 
only deactivate the unused item.

Name Description

Roles starting with “:” Default ECM roles; can be restored by the Reset 
Roles function.

Privileges starting with "Content:" Privilege related to creating, modifying or 
deleting content in ECM.

Privileges starting with "System:" Privilege related to administrative tasks in ECM.
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Assigning roles in ECM

Users do not need any specific role in order to log in to ECM. However, in 
order for users to see a particular Location, Cabinet, Drawer, or Folder in the 
user interface, they must have the :Reader role as a minimum requirement. As 
a result, domain users with no global roles might not be able to view anything 
in the content unless they were granted the appropriate privileges.

You should grant the ChemStation users the :Contributor role. This can be done 
at the global level for the entire ECM Account, or individually for specific 
folders (see “Roles and Folders in ECM” on page 95). The :Contributor role 
allows the ChemStation user to view and add content to ECM. The :Contributor 
role should be enhanced with the Content: Add Folder privilege. This allows 
ChemStation ECM users to add folders to the LCDF hierarchy.

In addition to the configuration of ECM roles, you must also configure 
ChemStation roles and privileges for ChemStation users. The configuration of 
ChemStation roles and privileges is done in the OpenLAB Control Panel.

You find a complete list of all ECM and ChemStation privileges in the 
Appendix.

NOTE If the role does not include the Add Folder privilege, the users cannot add a new Remote 
Data Path (LCDF) in ChemStation.
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Roles and Folders in ECM

ECM allows you to assign specific roles to users or user groups. This can be 
done at the global level for the entire ECM Account, or individually for specific 
folders. For example, a specific user group may have the Contributor role for 
folder A, but at the same time have only the Reader role for folder B. The roles 
you assign in ECM are only related to content storage in ECM; all roles related 
to ChemStation and instrument settings are assigned in OpenLAB Control 
Panel.

To enable roles for folders:

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Users/Groups/Roles item. 

The Account Administration dialog opens.

4 On the Roles tab, select the required role and click Edit.

5 Select the Available in folder access tab check box.

Users, Roles, and Privileges Concept with Data Store

With Data Store, all users, groups, roles, and privileges are configured in the 
OpenLAB Control Panel. You can use Windows as an external authentication 
provider, but you set up all roles and privileges related to OpenLAB in the 
OpenLAB Control Panel. ChemStation and Data Store refer to these settings.

Preparations If you want to assign roles at the folder level, you must first enable this feature in ECM. The setting 
is valid for the complete ECM Account.
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ChemStation Administration Tool

The ChemStation Administration Tool offers a number of functions related to 
the ChemStation configuration. As one of these functions is to break the 
session lock, access to the ChemStation Administration Tool is strictly limited:

• The ChemStation Administration Tool can only be opened directly on the 
ChemStation PC. In Distributed System installations, you must open the 
tool on the relevant AIC.

• The ChemStation Administration Tool can only be started by users who are 
a member of the local user group CSAdministrators (see “Enabling users to 
start the ChemStation Administration Tool” on page 97).

To start the ChemStation Administration Tool:

1 From the Start menu in the Task Bar, select Start > All Programs > Agilent 
Technologies > OpenLAB CDS ChemStation Edition > ChemStation Administration 
Tool.

Figure 22 ChemStation Administration Tool
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Enabling users to start the ChemStation Administration Tool

During the Installation of OpenLAB CDS ChemStation Edition, the local user 
group CSAdministrators is automatically created. Only members of this group 
are allowed to run the ChemStation Administration Tool. The user who 
installs ChemStation, is automatically added to the CSAdministrators group. 
Additionally, the Windows group Administrators and the user who installs 
ChemStation are granted Full Control privileges on the Administration Tool 
program executable (Agilent.ChemStation.ECM.ECMAdmin.exe) itself, thus 
they are able to run the tool.

To add a Windows user to the CSAdministrators group:

1 From the Start menu in the Task Bar, select Start > Settings > Control Panel > 
Administrative Tools > Computer Management.

The Computer Management window opens.

Figure 23 Computer Management window

2 Right-click the group CSAdministrator and select Add to Group... from the 
context menu.

The Properties dialog shows the users who are currently member of the 
group.
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3 Use the Add button to add the required users.

After confirming with OK, the Properties dialog also contains the newly 
added users.

Session Lock Settings

Figure 24 ChemStation Administration Tool

In the ChemStation Administration Tool, you can set the following options for 
creating and breaking session locks:
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• Break session lock: If you select this check box, a locked ChemStation can be 
accessed by any user just by clicking Cancel in the Login dialog. If a 
ChemStation is currently locked and the authentication provider is 
unavailable, selecting this check box is the only way to regain access to the 
current ChemStation session.

• Time based session lock locks private: If ChemStation has been locked by a 
session time out, only the current user or a user with the required 
privileges can unlock this session.

• Toolbar lock button locks private: If ChemStation has been locked using the 
Lock button on the ChemStation toolbar, only the current user or a user 
with the required privileges can unlock this session.

Data Handling and Audit Trail Configuration 

The ChemStation Administration Tool offers to conveniently configure all 
ChemStation instances on a client at the same time with the same settings. By 
default, the option Use instance specific settings is selected, so that the settings 
are not overwritten.

To change the settings for all ChemStation instances

1 Click OK.

2 Select the required check boxes. The settings are the same as in the 
Preferences dialog (see “Preferences” on page 30).

3 Select the option Use these settings for all instances on this computer.

4 Select the required check boxes. The settings are the same as in the 
Preferences dialog (see “Preferences” on page 30).

5 Click OK.

NOTE Be aware that, as a consequence, the user who regained access to ChemStation now has 
unlimited access to all ChemStation functions.
ChemStation with Central Data Storage Concepts Guide 99



4 Administration Regarding 21 CFR Part 11 Compliance
ChemStation Administration Tool
Configuration Profiles

By providing specific client services profiles, you activate specific functions 
and behaviors in ChemStation. The following profiles are relevant if you use 
OpenLAB Shared Services:

• Olss

ChemStation communicates with OpenLAB Shared Services; it sends status 
information to OpenLAB Shared Services, and uses the settings defined in 
OpenLAB Shared Services (for example, user authentication, roles and 
privileges, configuration settings, audit trail settings). Use this profile for 
ChemStation instances that are connected to OpenLAB Shared Services, 
but have no connection to a central data storage system.

• OlssEcm

In addition to communication with OpenLAB Shared Services, 
ChemStation allows transferring data files to and from OpenLAB ECM. Use 
this profile for ChemStation instances that are connected to both OpenLAB 
Shared Services and OpenLAB ECM.

In an emergency scenario, where the connection between the workstation 
and OpenLAB ECM is interrupted, you can set the authentication provider 
in OpenLAB Shared Service to None. This allows you to log on to 
ChemStation in the absence of OpenLAB ECM. 

In this case, using the OlssEcm profile allows ChemStation to send the data 
files to the queue. Once the authentication provider in OpenLAB Shared 
Services is set back to ECM, the upload can be resumed.

• OlssDataStore

In addition to communication with OpenLAB Shared Services, 
ChemStation allows transferring data files to and from OpenLAB Data 
Store. Use this profile for ChemStation instances that are connected to both 
OpenLAB Shared Services and OpenLAB Data Store.
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Electronic Signature

Electronic signatures provide a means to sign documents as equally binding as 
a handwritten signature. In addition, electronic signatures are reproducible, 
because they are recorded in a secure, time stamped audit trail. Manipulation 
is prevented by enabling only users with specific privileges to sign 
electronically.

An electronic signature contains the user name (full name), date, and time 
when the signature was applied, the location where the signing occurred, and 
a user-configurable definition associated with the signature. The signature is 
always related to the complete result set, not to a single file inside the SSIZIP 
file.

CFR 21 Part 11 requires that companies, especially ones that employ any type 
of approval process, use electronic signatures. 

With OpenLAB ECM, you can use the Agilent OpenLAB Business Process 
Manager (BPM) module as an Add-on to create highly automated review or 
approval processes including e-mail notification.

Preparation

Privileges

Users must have a specific privilege in order to be able to sign electronically.

With ECM, a user must have the privilege Content: File Signatures. This privilege 
is, for example, assigned to the default role :Approver in ECM.

With Data Store, a user must have the privilege E-Signature Sign Files.

Reasons for the signature

With each signature, the users must either select a given reason or, if they are 
allowed to, provide their own reason. 
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With ECM, you can either restrict the users to the given reasons or allow them 
to provide their own reason. Also, you can configure the list of given default 
reasons.

With Data Store, the list of given default reasons cannot be configured, and 
users are always allowed to provide their own reason.

To allow specific signature reasons in ECM:

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Electronic Signature item. 

The Account Administration dialog opens.

4 To provide a new reason, enter the required text into the Reasons field and 

click .

5 To delete an existing reason, select the reason in the Default reasons list and 

click .

6 If you want to allow users to provide their own reason with a signature, 
select the User can specify reason check box. 

7 If necessary, adjust the timeout settings:

• The Signature screen timeout defines, how long an e-signature dialog will 
stay open if no signature is submitted. The default setting is 5 minutes.

• The Consecutive signature timeout is relevant if an ECM user carries out 
several successive e-signatures. If the next e-signature takes place within 
the given timeout interval, the location and the reason provided in the first 
e-signature will be pre-filled in the next dialog. The default setting for the 
consecutive signature timeout is 5 minutes.

NOTE If you clear this check box, the users can only select one of the given default reasons.
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Using electronic signatures

To apply an electronic signature in ECM

1 Right-click the required SSIZIP file and select Electronically Sign > Electronic 
Signature from the context menu.

The Electronic Signature dialog opens.

2 Enter your ECM user credentials (username, password, and domain).

3 Enter your current location. With this information, the location from where 
you provide the signature is reproducible.

4 Select a reason for the signature from the Default reason drop-down list.

- Or -

Select the User specified check box and enter a different reason into the text 
field. Note that this option is only available if the ECM Account is 
configured accordingly.

5 Click Sign.

The file is now signed electronically. The e-signature is shown in the file 
properties in the eSig tab. The e-signature is also included in the ECM Audit 
Trail.

To apply an electronic signature in Data Store

1 In Data Store, navigate to the respective file and click the Properties icon  
of this file.

A file preview is shown, together with several document properties and a 
list of document actions.

2 Under Document Actions, click Sign File.

The Sign File dialog opens.

3 Enter your login credentials for OpenLAB CDS.

NOTE The other command in the context menu, Electronically Sign > Acrobat Plug-In 
Signature, works only for PDF documents and only if you purchased the respective plugin. 
It enables you to add signatures directly inside PDF documents.
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4 Select a reason for the signature from the Reason drop-down list.

OR

Select the reason Other, and enter a different reason into the text field.

5 Click OK.

The file is now signed electronically. The e-signature is shown in the list of 
signatures under Version History.

To view electronic signatures in ChemStation

1 In the ChemStation Explorer, right-click the respective file.

2 Select ECM Properties... or Data Store Properties... from the context menu.

This command is only available if the file has been uploaded to central data 
storage.

3 In the File Properties dialog, select the eSig tab. 

The electronic signature history for the file, including the date, signer's full 
name, and reason for each signature are listed.

To view electronic signatures in ECM

The electronic signature itself is shown in the file properties in the eSig tab, 
and it is also part of the ECM Audit Trail.

The user preferences in ECM can be configured in such a way that the number 
of e-signatures applied to a file is shown by default in the ECM content display, 
together with the file name and status.

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the User Preferences item. 

4 Click Modify... to modify the column settings.

5 Select # of signatures and click  to add this property to the selected 
columns.

6 Click OK.

The number of e-signatures is then shown on every content page in ECM.

To view electronic signatures in Data Store

All e-signatures applied to a file are listed under Version History in the 
Properties page of the file.
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This chapter provides an overview of the filter and search options for 
ChemStation data in the central data storage system.
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Attribute Extraction Services in ECM

ECM Attribute Extraction Services (AES) provides the following AES for the 
extraction of metadata from ChemStation data files:

• The ACAML filter extracts all information contained in the .acaml files, 
which are part of the SSIZIP files uploaded by ChemStation revision 
B.03.02 and later.

• The ChemStation XML filter extracts peak, compound and result data from 
the result.xml file generated by the XML export routine in ChemStation 
revision A.10.02 and later.

• The ChemStation filter extracts basic sample and run data from the header 
of the channel files (*.ch), *.uv and *.txt files generated by all ChemStation 
revisions.

AES need to be installed by an ECM Administrator on the ECM Server; in 
addition, the filters need to be enabled for the system. The keys of an AES that 
are to be applied to a ChemStation file need to be selected for the respective 
LCDF structure. These are ECM administration tasks, and are described in the 
Enterprise Content Manager Administrator’s Guide and the ECM online help.

The metadata can be queried using various search types in ECM. The ECM 
Search functionality is also available within ChemStation. When opening a file 
from ECM, the ECM Open dialog allows you to search for files of interest using 
the ‘magnifying glass’ icon, see Figure 25 on page 107.

Using the Quick Search, you can search through various alphanumeric fields 
by entering a search key, such as an operator name. On the upcoming search 
page, you select the Advanced tab where, depending on the enabled filter 
packages, various keys are enabled, see Figure 26 on page 107.
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Figure 25 Search options

Figure 26 Filters available in search options
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In the Search dialog, you can specify the available keys, and it is possible to 
define a search expression by combining two or more of the available keys 
using boolean operators. For detailed information regarding the use of the 
various search algorithms, refer to the online help of your ECM system or the 
Enterprise Content Manager Administrator’s Guide, as well as the AES-related 
manuals.

ACAML Filter

ChemStation stores all data in the ACAML format (ACAML = Agilent Common 
Analytical Markup Language), which results in .acaml files. There is one 
.acaml file for each sequence or single run. The .acaml files are always created 
when acquiring or reprocessing data.

When the data is uploaded to ECM, the .acaml file is part of the SSIZIP file. 
The ACAML filter extracts information from these files.

Please note that the ACAML filter is only available as of ECM 3.3.2 SP1.

ChemStation XML Attribute Extraction Service

The AES for ChemStation XML extracts key information from the following 
categories of the result.xml generated by ChemStation per data file. Note that 
ChemStation must be configured to generate the result.xml file, see the 
ChemStation XML Connectivity Guide. 

• Acquisition (for example, instrument name, method information)

• Chromatogram (for example, derivative order, detector name)

• Custom

• Module

• Peaks (for example, peak name, amount, retention time, compound name)

• Sample (for example, calibration method, LIMS ID)

• Signal/noise
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ChemStation Filter

The AES for ChemStation extracts attributes from *.ch, *.uv, and *.txt files 
created by the 16-Bit ChemStation (Rev A.x.x) or 32-Bit ChemStation (Rev 
B.x.x or later). It extracts key information from the header of ChemStation 
*.ch and *.uv data files (for example, sample name, method file, instrument 
model). From the report.txt file, it extracts key information (for example, 
sample name, acquisition method, analysis method). In addition, the service 
extracts information on support files from the category Content.

An ECM Scheduler Add-in for Agilent ChemStation enables the ECM 
Scheduler to automatically upload data generated by ChemStation to ECM.
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Search Options in Data Store

Using the Advanced Search

ChemStation stores all data in the ACAML format (ACAML = Agilent Common 
Analytical Markup Language), which results in .acaml files. There is one 
.acaml file for each sequence or single run. The .acaml files are always created 
when acquiring or reprocessing data. When the data is uploaded to the central 
data storage, the .acaml file is part of the SSIZIP file.

When using the advanced search in Data Store, you can limit your search to 
specific metadata based on the values given in the .acaml file

1 In the top pane, click the search icon .

2 From the Select field drop-down list, select the field which you would like to 
use. You can use, for example, the following fields:

• Acquisition Operator

• Compound

• File name

• Method Name

• Sample Name

• Sequence Name

The corresponding search expression is entered in the search field.

3 In the search field, click Type here, and type your search criteria. 

4 Click Search.

For more information, refer to the Data Store documentation.
110 ChemStation with Central Data Storage Concepts Guide



ChemStation with Central Data Storage Concepts Guide
6
Troubleshooting

Error messages at OpenLAB Control Panel Startup 112

Alerts and Error Messages at ChemStation Startup 113

ECM or Data Store Server is not available after login 114

Error Messages in the Queue Management 115

Independent of Storage Type 115

ECM-Specific Messages 115

Data Store-Specific Messages 117

The chapter gives some elementary troubleshooting hints.
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Error messages at OpenLAB Control Panel Startup

Connection to Shared Services failed

When the ECM server or the OpenLAB Shared Services server is not available, 
the user cannot start the OpenLAB Control Panel. As ChemStation is launched 
from OpenLAB Control Panel, working with ChemStation is not possible.

When only the Data Store service is not available, the user can start OpenLAB 
Control Panel and work with ChemStation, but he cannot transfer data to 
OpenLAB Data Store.

Probable cause Suggested actions

1 The Data Store service is not available. Start OpenLAB Control Panel and work only 
with local data in ChemStation.

2 The ECM server or Shared Services server is 
not available.

• Reconnect: Try again to start the OpenLAB 
Control Panel.

• Ping: Ping the Shared Services server.

• Switch to Failover mode: If the connection 
to the Shared Services server cannot be 
re-established in a short period of time, 
switch to Failover mode. For more 
information, refer to the technical note 
OpenLAB CDS ChemStation Edition – 
Emergency Procedures.
112 ChemStation with Central Data Storage Concepts Guide



Troubleshooting 6
Alerts and Error Messages at ChemStation Startup
Alerts and Error Messages at ChemStation Startup

Your Transfer Settings (Remote Data Path) differ from the current 
connection. Change Transfer Settings now?

At every startup, Agilent ChemStation checks whether all necessary 
information is provided for transferring data to the central data storage. This 
message is shown if the information on the Server provided in the Transfer 
Settings differs from the server configured in OpenLAB Control Panel.

Probable cause Suggested actions

1 The Transfer Settings in ChemStation differ 
from the configuration in OpenLAB Control 
Panel.

Make sure that the correct information on 
Server, Account, and Path is provided in the 
Transfer Settings (ECM > Preferences > 
Transfer Settings or Data Store > Preferences 
> Transfer Settings).
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ECM or Data Store Server is not available after login

If the connection to the ECM or Data Store Server is interrupted after login to 
the OpenLAB Control Panel, the user has already been authenticated by the 
external system. In this case, ChemStation knows the current logged-in user.

When the ECM or Data Store Server becomes unavailable, ChemStation 
automatically tries to reestablish the user login.

The Load and Save functions are accessible, but an alert informs the user 
about the interrupted connection to the central data storage system.

While acquiring data, the automatic transfer of data to the central data storage 
cannot be completed. The user is notified by an error message. and must 
manually upload the data as soon as the connection is reestablished (ECM > 
Manage Queue or Data Store > Manage Queue).

As soon as the ECM or Data Store Server is available again, all tasks are 
available without restarting the application. A new login is not required.

For further troubleshooting, please contact the administrator for the central 
data storage system.
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Error Messages in the Queue Management

Independent of Storage Type

The queue already contains items

Invalid URI: The format of the URI could not be determined

ECM-Specific Messages

Current connection to '<account1>', expected connection to 
'<account2>'

Probable cause Suggested actions

1 There are items in the queue that have been 
queued before the current item.

Process queue in the correct order. If 
necessary, export items that can't be resolved.

Probable cause Suggested actions

1 In the preferences, the ECM or Data Store 
server is missing or has been entered by 
name only, not as URI (http:\\servername\
).

Correct the server in the preferences, e.g. by 
using Get Server. Save existing items in the 
queue to the local file system. After correcting 
the server setting, reprocess the data.

Probable cause Suggested actions

1 ECM Account setting in Preferences differs 
from current connection.

Correct the Transfer Settings.
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Currently no connection, expected connection to '<server>'

You do not have permission to create a new Drawer/Folder.

You do not have permission to add files. 

Unable to upload (filename). This file is currently checked out to 
another user and may not be updated. (error -1).

Probable cause Suggested actions

1 The ECM Server is not available. Contact your ECM administrator.

2 In the OpenLAB Control Panel, the storage 
is not set to ECM.

Select ECM as the storage type in OpenLAB 
Control Panel, or ask your system administrator 
to do so.

Probable cause Suggested actions

1 You do not have appropriate privileges to 
create the Drawer or Folder in ECM.

Ask an administrator to give you the 
corresponding privileges or to create the 
needed directories.

Probable cause Suggested actions

1 You do not have appropriate privileges to 
save files to the specified location in ECM.

Ask an administrator to give you the 
corresponding privileges.

Probable cause Suggested actions

1 Another user has checked out the file from 
ECM.

The other user has to check in the file before 
you can upload the file.
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Data Store-Specific Messages

No connection to remote storage established

Connection to remote storage is broken.

You cannot upload a file that is checked out by another user

You do not have appropriate permissions to create a folder

Probable cause Suggested actions

1 The Data Store service is not available. Contact your Data Store administrator.

Probable cause Suggested actions

1 The connection to Data Store has become 
unavailable during the current session.

• Wait for the connection to be reestablished.

• Contact your Data Store administrator.

Probable cause Suggested actions

1 The file you want to upload is currently 
checked out by another user.

Ask the other user to check in the file, then 
upload again.

Probable cause Suggested actions

1 You do not have the privilege to create 
content in Data Store.

Ask an administrator to give you the Save data 
to storage privilege.
ChemStation with Central Data Storage Concepts Guide 117



6 Troubleshooting
Error Messages in the Queue Management
118 ChemStation with Central Data Storage Concepts Guide



ChemStation with Central Data Storage Concepts Guide
7
Appendix

Privileges in OpenLAB Control Panel 120

Project Privileges 120

Instrument Privileges 125

Administrative Privileges 126

ECM Privileges related to ChemStation 128
119Agilent Technologies



7 Appendix
Privileges in OpenLAB Control Panel
Privileges in OpenLAB Control Panel

Project Privileges

Table 9 Project Management

Name Description

View project or project group User can see a project and project details but 
cannot edit. With Data Store: User can view the 
content of the Data Store repository. 
Note:This privilege is required for all users, even 
if ChemStation does not support projects yet.

Manage project or project group User can create or edit project properties and 
can move the project but cannot access 
settings (EZChrom only; Projects are not 
supported in ChemStation).

Edit content of project Only relevant for Data Store: User can create 
new versions of documents in Data Store.

Manage project or project group access User can view and edit the project access 
settings (EZChrom only; Projects are not 
supported in ChemStation). 

Table 10 E-Signature

Name Description

E-Signature Sign Data Files User can sign data files (with ChemStation, this 
privilege is only relevant if you use OpenLAB 
Data Store).

Table 11 Intelligent Reporter templates

Privilege Description

Edit Intelligent Reporter report template Only relevant for OpenLAB ECM Intelligent 
Reporter: This privilege is required to edit report 
templates in the Reporter Client
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Table 12 ChemStation: Control

Privilege Description

Run Acquisition Start acquisition (single sample or sequence).

Table 13 ChemStation: Data

Privilege Description

Delete Data User can delete data files in ChemStation 
Explorer.

Manual Integration User can perform manual integration. 

Save data to storage Interactive saving of data to the central data 
storage system.

Table 14 ChemStation: Instrument

Privilege Description

Modify instrument configuration User can modify the instrument configuration 
parameters.

Table 15 ChemStation: Logbook

Privilege Description

Clear Logbook Clear the current logbook.

Save Logbook Save the current logbook.
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Table 16 ChemStation: Method

Privilege Description

Edit calibration table Create and modify the calibration table; change 
calibration settings.

Delete method Delete a method in ChemStation Explorer.

Edit integration events Modify integration events and perform Auto 
Integration.

Edit ion labels Edit options for ion labels (LC/MS only).

Edit system suitability Edit noise ranges and performance limits.

Enable audit trail Enable the audit trail for a specific method.

Modify instrument method Modify instrument method parameters.

Modify method properties Modify Run Time Checklist and Method 
Information.

Perform method recalibration Perform interactive recalibration.

Save method changes Save method changes (includes Update 
Sequence/Master Method in Data Analysis 
view).

Table 17 ChemStation: Report

Privilege Description

Preview/print report User can preview/print a report. 

Modify report User can modify report calculation/print style 
and can edit Instrument Curves dialog. 

Lock/unlock report template items Only relevant with Intelligent Reporting: User 
can lock or unlock report items and composite 
groups in a report template.
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Table 18 ChemStation: Security

Privilege Description

Break session lock Unlock a ChemStation session locked by other 
users.

Command line Turn on / off the command line

Manage transfer queue Access to the Transfer Queue and the Queue 
Management.

Modify storage transfer preferences Enable / disable the automatic upload to the 
central data storage system.

Take over ChemStation Remote Session Only relevant for ChemStation in a Distributed 
System: User can take over a running remote 
session.

Table 19 ChemStation: Sequence

Name Description

Delete sequence User can delete sequences in ChemStation 
Explorer. 

Edit sequence summary User can modify sequence summary report and 
extended statistics settings.

Reprocess User can reprocess a sequence. 

Save sequence template User can save sequence templates locally (on 
workstation or AIC).
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Table 20 ChemStation: View Access

Privilege Description

Access Data Analysis view User has access to Data Analysis view.

Access Diagnostic view User has access to Diagnostic view.

Access Method & Run Control view User has access to Method and Run Control 
view.

Access retention time lock User has access to the Retention Time Lock 
menu (GC only).

Access retention time search User has access to Retention Time Search 
menu (GC only).

Access Review view User has access to Review view

Access Tune view User has access to Tune view (LC-MSD 
ChemStation only).

Access Verification view User has access to Verification (OQ/PV) view.

Access Report Layout view User has access to Report Layout View, ability 
to create/edit/save report templates.

Enable Batch view Enables all operations in Batch view.
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Instrument Privileges

Table 21 Instrument Management

Name Description

View instrument or location User can view and access a location in the tree, 
but not edit access security, can view 
properties.

Manage Instrument or location User can create and move locations and edit 
properties (name, description etc).

Manage instrument or location access User can view and edit the location access 
settings.

Run instrument User can start an instrument session.

Service instrument User can lock or unlock an instrument (to 
service it).
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Administrative Privileges

Table 22 System Administration

Name Description

Manage printers Can add/remove printers and print server. 

Edit activity log properties Can change the Activity log Settings in 
OpenLAB Control Panel (that is, can turn 
logging on for the System Activity Log).

Create administrative reports Can create any of the system admin reports. 

Manage system components Can install/remove components (applications).

Manage Security Can change security settings.
Can edit (add, change etc) users, groups and 
roles.
Note: A user with this privilege can grant 
himself access to all settings in OpenLAB 
Shared Services. Be careful who you grant the 
Manage Security privilege.

Manage instrument controllers Can edit AIC configuration, manage the AICs in 
configuration UI.

Unlock any locked UI Can login into any locked portal or instrument 
session (will be a re-login), even if privately 
locked. 

Manage Data Store admin settings User can access the Admin sub folder of the 
Applications root note in Data Store. 

Table 23 Data Store

Name Description

Archive content User can archive the content of the Data Store 
repository.
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Table 24 Lab Applications privileges

Name Description

Access Lab Applications User can see the Sample Submission dashlet 
and can access the Lab Journal and Lab Apps 
Editor toolbar items.

Create/edit sample submission forms User access the Create Sample Submission 
commands in the Sample Submission dashlet 
and in the Lab Applicatons Editor.

Review/validate User can be assigned as a reviewer or validator 
of a lab event or service form.

Manage Lab Journal instruments User can create, edit, delete, or deactivate a Lab 
Journal instrument. 

Manage lab events User can create, edit, delete, or deactivate a lab 
event. 

Manage service forms User can create, edit, delete, or deactivate a 
service forms. 

Manage columns User can create, edit, delete, or deactivate a 
column. 

Manage samples User can create, edit, or delete samples. 
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ECM Privileges related to ChemStation

The privileges described in the following table must be assigned to at least one 
of your roles in order to become active.

Table 25 List of ECM related privileges

Privilege View Edit Delete Add Run Description

Content: File X X • Minimum privilege for ChemStation 
to access ECM

• Privileges to view ECM Properties 
in ChemStation

Content: File Filtering X • Minimum privilege for ChemStation 
to access ECM

• Privilege to add files manually to an 
ECM folder

Content: File Revisions X • Privilege to view revisions in 
ChemStation

Content: File Type [XLS] X X • Privilege to add and check in files 
with an .xls extension

Content: Folder X X X • Minimum privilege for ChemStation 
to access ECM

• Privilege to view ECM Properties in 
ChemStation

Content: Folder Access 
Properties

X • Privilege to view and change any 
folder property tab

Content: Rekey File X • Privilege to rekey files in ECM e.g. 
with XML Filters

System: Advanced Search X • Privilege to use the Advanced 
Search in ChemStation 

System: Audit Trail X • Privilege to view ECM Properties in 
ChemStation
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System: Filtering 
Configuration

X • Privilege to view or change the 
filtering configuration

• Privilege to use attribute extraction 
services and to manage 
user-defined attributes

System: indexing 
Configuration

X • Minimum privilege for ChemStation 
to access ECM

• Privilege to view ECM Properties in 
ChemStation

System: Quick Search X • Privilege to use Quick Search in 
ChemStation 

System: Super Object X • Privilege is mandatory for OLIR

System: Project X • Privilege to view projects in OLIR

System: Project Access X • Privilege to access projects in OLIR

Table 25 List of ECM related privileges

Privilege View Edit Delete Add Run Description
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